
Learning the
Illustrator
Interface

Not too long ago, commercial artists and illustrators
worked by hand, not on computers. It might seem

hard to believe, but they spent hours and hours with 
T-squares, rulers, French curves, and type galleys from
their local typesetters.

Now, of course, most artists and artist wannabes spend hours
and hours with their computers, mouses (or should that be
mice?), monitors, and onscreen type that they set themselves.
Some traditional artists are still out there, of course, but more
and more make the transition to the digital world every day.

Once that transition is accomplished, computer artists usually
come face-to-face with Illustrator, the industry-standard,
graphics-creation software for both print and the Web. The
following is a typical example of how people get to know
Illustrator.

Picasso Meets Illustrator: 
Getting Started

Illustrator arrives and the enthusiastic artist-to-be — we’ll
call him Picasso — opens the box, pops in the CD-ROM, and
installs the product, while glancing at the quick reference
card and thumbing through the manual. A few minutes later
Picasso launches Illustrator and is faced with a clean, brand
new, empty document. A world of possibilities awaits, only a
few mouse clicks away. But Picasso is a little intimidated by
all that white space, just as many budding young writers
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4 Part I ✦ Illustrator Basics

wince at a new word processing document with the lone insertion point blinking
away.

So, Picasso decides he’ll “play” with the software before designing anything
“for real.” He chooses the rectangle tool first, clicks, drags, and voilà! A rectangle
appears on the screen! His confidence soars. He may try the other shape tools next,
but sooner or later Picasso starts playing with some of the software’s other features.
Eventually, he eyes the dreaded Pen tool. And thus starts his downward spiral into
terror.

Confusion ensues. Hours of staring at an Illustrator document and wondering “Why?”
take up the majority of his time. Picasso doesn’t really understand fills and strokes,
he doesn’t understand stacking order and layers, and he certainly doesn’t under-
stand Bézier curves.

Even Picasso’s painting-factory boss can’t help him much with Illustrator; questions
result in a knowing nod and the customary tilt and swivel of his head toward the
Illustrator manual. Picasso goes through the tutorial three times, but whenever he
strays one iota from the set-in-stone printed steps, nothing works. Picasso becomes
convinced that the Pen tool is Satan’s pitchfork in disguise. Patterns make about as
much sense as differential equations. Then he encounters things such as effects
that can be edited later (huh?), miter limits for strokes (yeah, right), and the differ-
ence between targeting a group or all the objects in that group (huh? again). All are
subjects that might as well have been written about in a third-century Chinese
dialect, such as the hard-to-find Chinese Book of Patterns.

Picasso had never used or seen software as different as Illustrator.

Ah, but you have an advantage over Picasso. You have this book. The following
sections in this chapter start with an overview of the user interface and all the
different controls that will enable you to do great things. The remaining chapters
in this part will focus on the basics of Illustrator, including topics that range from
setting up a new document to understanding exactly what paths are and how
Illustrator uses them.

Getting started with Illustrator
The first step in getting started is to install the software. Appendix D, “Installing
Illustrator,” helps you with this process, which is slightly different depending on the
type of computer you are using. Once installed, you can launch Illustrator in one of
the following ways:

✦ Double-click its application icon

✦ Double-click an Illustrator document

✦ In Windows, choose Start ➪ Programs ➪ Adobe Illustrator 
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5Chapter 1 ✦ Learning the Illustrator Interface

Quitting Illustrator
End your Illustrator session at any time by choosing File ➪ Quit (or Exit). This
action closes the current document (you’ll be prompted to save it if it hasn’t been
saved) and exits the application. Window users can also close Illustrator by right
clicking on the program’s task bar icon and choosing Close (or by pressing Alt + F4)
from the pop-up menu. Mac OS X users can click and hold (or Ô+click) on the
Illustrator icon in the dock and choose quit from the menu that appears.

For Mac OS X, the Quit menu is under the Illustrator menu. Note

Who’s the Model on the Adobe Illustrator Box?

The woman that adorns the Adobe Illustrator box is Venus, goddess of love, from Sandro
Bottecelli’s Birth of Venus painting. A portion of the painting, shown in the following figure,
appears as the program is installed, when Illustrator launches, and in the Help ➪ About
Illustrator dialog box. It is also included at the top of the Toolbox in case you get lonely. 

Sandro Bottecelli’s Birth of Venus

Venus has graced each and every Illustrator package since Illustrator 1, released back in
1987. With Illustrator 9 came the introduction of the first all-vector replication of Venus and
Illustrator 10’s version is even more realistic. Earlier versions of Illustrator included a raster
version of Venus. She’s the official Illustrator “mascot,” gracing not only boxes but user
guides, splash screens, and icons as well. A good-sized print of Bottecelli’s painting hangs in
a hallway in the middle of the Illustrator engineering team’s offices at Adobe Systems head-
quarters in San Jose, California. Bottecelli would be proud.
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6 Part I ✦ Illustrator Basics

If you run into a situation in which the Quit function doesn’t work, or is unavailable,
Mac OS 9 users can press Ô+Option+Esc, Mac OS X users can hold down the Option
key while Ô+clicking on the dock and selecting the Quit changes to Force Quit (or
users choose the Force Quit option from the Application menu and select Illustrator
from the Force Quit dialog box) and Windows users can press Ctrl+Alt+Delete to
“force” Illustrator to quit. However, doing so may cause you to lose your work and
may make your system unstable; if you do this, you’ll be better off if you take the
time to restart your computer before running Illustrator again (or before opening
any other software applications, for that matter). Restarting isn’t necessary for Mac
OS X users. 

One of the most likely reasons that Illustrator becomes unstable is due to a lack of
memory. If the computer on which you are running Illustrator doesn’t have enough
memory, then working on large complex images will cause the interface to respond
slowly, and if many other programs are open at the same time, Illustrator may quit
responding.

Using the User Interface Elements
Before you can create amazing illustrations using Illustrator, you’ll need to learn the
tools and controls of Illustrator’s user interface. If you’ve used other Adobe products
such as Photoshop or InDesign, the user interface should look familiar. Adobe has
made user interface elements consistent across their product line. Adobe’s main
products, including Illustrator, Photoshop, InDesign, PageMaker, Premiere,
Dimensions, and Streamline, all have a fairly consistent interface that includes
menus, palettes, and dialog boxes. Adobe listened carefully to its users and has
made certain that the Illustrator environment is very similar to that of the other
software products its users typically use. This gives Photoshop users a headstart
into understanding and using Illustrator and vice versa.

The Illustrator user interface includes many unique elements that hold a lot of
power. As you learn to use these elements, you’ll discover many shortcuts to
accomplish certain tasks. The Illustrator elements, shown in Figure 1-1, include
the following:

✦ Document Window: The document window consists of the Artboard and the
Pasteboard where the actual artwork will be displayed. 

✦ Toolbox: This palette includes a set of common tools. Each tool is represented
by an icon that can be selected by clicking on it. 

✦ Palettes: These tabbed floating windows can be opened and closed as needed.
They contain an assortment of controls and settings. 

✦ Menus: At the top of the window are menus that open to submenus of options
and commands.

Note
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7Chapter 1 ✦ Learning the Illustrator Interface

✦ Status Bar: Along the lower left edge of the window is an area that displays
information about the current state of the selected tool. 

Figure 1-1: Illustrator includes many different user interface elements.

Working in the Document Window
The document window is where you perform all your work. It contains two main
elements: the artboard and the page. The page (sometimes referred to as the
pasteboard) is always centered in the artboard, as shown in Figure 1-2 and all the
palettes have been closed in order to make the full document window visible. You
can move the printable area represented by the dashed lines using the Page tool,
which is explained later in this section. 

PalettesMenus

Toolbox Document windowStatus bar
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8 Part I ✦ Illustrator Basics

Figure 1-2: The document window contains the page, surrounded by the artboard.

Illustrator windows act like windows in most other programs. You use the title bar
at the top of the window to move the window around your screen. On the title bar
is the name of the document. If you have not yet saved your document, the name of
the document is Untitled-1, with the number changing for each new document you
create. (Hint: Save it as soon as you create it!) Next to the title of the document is
the current viewing percentage relative to actual size.

The scroll bars on the right side of the window let you see what is above and below
the current viewing area (see “Using the scroll bars to view your document,” later
in this chapter). 

In Windows, the upper right corner of the document window includes three
buttons — Minimize, Maximize and Close. In OS X, the Close, Minimize and Zoom
buttons are on the left and in OS 9 or earlier, the Close button is on the left and the
Zoom and Windowshade buttons are on the right. These buttons work exactly the
same as the similar buttons on application window. In Windows, the Minimize
button will display the document window as an icon along the bottom edge of the
application window. Once minimized, a Restore button appears which will return

Page Artboard

033658-3 ch01.F  1/24/02  12:59 PM  Page 8



9Chapter 1 ✦ Learning the Illustrator Interface

the document window to its former size and position. In OS X, the document will
change to an icon in the dock. In OS 9, the document will rollup until only the title
bar is displayed.

The Maximize button in Windows will open the document window to the largest
size that will fit in the application window. For Macs, the Zoom button will toggle
the between its current size and the screen’s maximum size. The Close button will
close the window and offer a dialog box where you can save the current file if it
hasn’t been saved. Multiple document windows can be opened at the same time
and the title of each open document window will be displayed at the bottom of the
Window menu. A checkmark will appear in the Window menu next to the current
active document window. 

Although only one document window is active at a time, several document windows
can be opened at a time. The Window menu includes a couple of commands that
make it easy to see all the opened document windows. Window ➪ Cascade will line
up the title bars of all the opened document windows, Window ➪ Tile will tile the
opened document windows next to one another to fill the application window and
Window ➪ Arrange Icons will arrange all the minimized icons into neat rows.
Figure 1-3 shows two document windows opened next to each other. 

The Cascade, Tile and Arrange Icons options are only available for Windows
computers. 

Figure 1-3: Multiple document windows can be tiled next to one another.

Caution
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10 Part I ✦ Illustrator Basics

The artboard
The artboard is displayed in Illustrator using solid black lines and identifies the
maximum printable area. This area can be different than the actual printed page,
which is displayed as dotted lines. For example, you could have the page size set
to letter-sized and the artboard set to a smaller section in the center of the page.
When printing this document, only the art contained within the artboard will be
printed. 

The size, units and orientation of the artboard can be set using the Document
Setup dialog box, which is opened using the File ➪ Document Setup menu option.
Conversely, the printed page size is set using the Page [Print] Setup dialog box also
found in the File menu. 

You’ll typically want to keep the artboard and page size the same. To do this, just
enable the Use Print Setup option in the Document Setup dialog box. This will
change the artboard size and orientation to match the page setup. 

Using the View menu, you can hide the artboard with the View ➪ Hide Artboard
menu option. Once hidden, this menu option changes to View Artboard. Double
clicking on the Hand tool will quickly maximize the artboard within the Illustrator
window. 

If you are taking your Illustrator artwork into another application, such as Photoshop
or QuarkXPress, the size of the artboard is irrelevant; your entire illustration appears
in most other software applications even if that artwork is larger than the artboard.

The pasteboard
Probably the worst thing that can possibly happen when you are using Illustrator is
for you to lose everything you’ve worked on. “Where’d it all go?” you cry, perhaps
adding a few vulgarities. This can happen very easily in Illustrator. Just click a few
times on the gray parts of the scroll bars at the bottom of the document window.
Each time you click you’re moving about half the width (or height) of your window,
and three clicks later, your page and everything on it is no longer in front of you.
Instead you see the pasteboard, usually a vast expanse of white nothingness.

The pasteboard measures 227.5×227.5 inches, which works out to around 360 square
feet of drawing space. At actual size, you see only a very small section of the artboard.
A little letter-size document looks extremely tiny on a pasteboard this big. If you get
lost on the pasteboard, a quick way back is to choose View ➪ Actual Size. This puts
your page in the center of the window at 100-percent view, at which time you should
be able to see at least part of your drawing. To see the whole page quickly, choose
View ➪ Fit in Window, which resizes the view down to where you can see the entire
page.

Tip
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11Chapter 1 ✦ Learning the Illustrator Interface

This discussion assumes, of course, that you have actually drawn artwork on the
defined page. We used to get frantic calls from people who would choose Fit in
Window, resulting in the immediate disappearance of all their artwork. It took us
a while to figure out that they had drawn their artwork way off on the side of the
pasteboard.

The Page tool
The Page tool (found as a flyout to the Hand tool) changes how much of your
document will print; it does this by moving the printable area of the document
without moving any of the printable objects in the document. Clicking and
dragging the lower-left corner of the page relocates the printable area of the
page to the place where you release the mouse button.

Double-clicking the Page tool slot resets the printable-area dotted line to its original
position on the page.

The Page tool is useful when your document is larger than the biggest image area
your printer can print. The tool enables you to tile several pages to create one
large page out of several sheets of paper. Tiling is the process in which an image is
assembled by using several pieces of paper arranged in a grid formation. A portion
of the image is printed on each page, and when you fit the pages together you can
view the image in its entirety. This is really only good for rough laser prints, as a
quarter inch around the edge of each paper will need to be manually trimmed.

Chapter 16, “Understanding Printing, Separations, and Trapping,” further addresses
issues related to printing and changing page sizes and printing areas.

The toolbox
The toolbox appears on top of your document window, covering up part of your
document window in the upper-left corner. The toolbox (see Figure 1-4) has no
close box; to close it you must choose Window ➪ Tools. If the Tools menu has a
checkmark to its left, the toolbox is visible. If no checkmark exists, then the toolbox
is hidden. You can also press the Tab key (which hides all palettes, not just the
toolbox).

You can show and hide all the palettes except the toolbox by pressing Shift+Tab.

To choose a tool, click the tool you want to use in its slot within the toolbox and
release the mouse button. The background for the selected tool will be displayed
white to highlight it. The selected tool will stay active until you select another tool.
You can also choose tools by pressing a key on the keyboard; for instance, pressing
P selects the Pen tool.

Tip

Cross-
Reference

Tip
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12 Part I ✦ Illustrator Basics

Figure 1-4: The toolbox in its initial (default) state, with all tools labeled. 
The letter that appears in parentheses after each tool is the key you can 
press to quickly access that tool.

Many tools have additional pop-up tools called flyouts, which are tools that appear
only when you click and hold down the mouse on the default tool. The default tools
that have pop-up tools are indicated by a little triangle in the lower-right corner of
the tool. To select a pop-up tool, click and hold on a tool with a triangle until the
pop-up tools appear; then drag to the pop-up tool you want. The new pop-up tool
replaces the default tool in that tool slot. You can also browse through the tools by
Option [Alt]+clicking a toolslot; each click displays the next tool. Figure 1-5 shows
all the pop-up tools for each toolslot.

Any tool with a pop-up option also has a tearoff tab at the rightmost end of the fly-
out. If you click on this tearout tab, the flyout tools become a free-floating palette of
tools. Figure 1-6 shows the Graph tools as a floating palette.

Selection tool (V)
Magic Wand tool (Y)

Pen tool (P)
Line Segment tool (\)

Paintbrush tool (B)
Rotate tool (R)

Warp tool (Shift+R)
Symbol Sprayer tool (Shift+S)

Gradient Mesh tool (U)
Eyedropper tool (I)

Hand tool (H)

Direct Selection tool (A)
Direct Select Lasso tool (Q)
Type tool (T)
Rectangle tool (M)
Pencil tool (N)
Scale tool (S)
Free Transform tool (E)
Column Graph tool (J)
Gradient tool (G)

Scissors tool (C)
Zoom tool (Z)

Slice tool (Shift+K)

Adobe Online

Blend tool (W)

Swap Fill and Stroke (Shift+X)
Stroke (X)
None (/)
Full Screen mode (F)

Full Screen mode with menu bar (F)

Fill (X)
Default Fill and Stroke (D)

Color (<)
Standard Screen mode (F)

Gradient (>)
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13Chapter 1 ✦ Learning the Illustrator Interface

Figure 1-5: All the flyout tools in Illustrator

Add Anchor Point tool (+)

Convert Anchor Point tool (Shift+C)  Reflect tool (O)

Delete Anchor Point tool (-) Polar Grid tool

Pen tool (P)

Twist tool

Rotate tool (R)
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Slice Selection tool
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Type tool
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tool
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Star tool
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Slice tool (Shift+K)

Smooth tool

Pencil tool (N)

Page tool

Hand tool (H)

Erase tool

Shear tool

Scale tool (S)

Reshape tool

Group Selection tool

Direct Selection
tool (A)

Lasso tool

Direct Select
Lasso tool (Q)

Auto Trace tool

Blend tool (W)

Knife tool

Scissors tool (C)

Symbol Spinner tool

Symbol
Shifter tool

Symbol
Sizer tool

Symbol Stainer tool

Symbol Styler tool

Symbol
Scruncher tool Symbol Screener tool

Symbol Sprayer
tool (Shift+S)

Line Graph tool
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14 Part I ✦ Illustrator Basics

Figure 1-6: A free-floating 
palette of tearout tools

Tooltips
If you ever forget what a specific tool looks like or have trouble finding it, you simply
need to stop and think about it for a second and maybe, just maybe, the answer will
pop into your mind. Or it will pop onto the screen. Tooltips are pop-up text that
appears next to the cursor if you leave it over the top of an interface element. For
example, if you hold the mouse cursor over the Selection tool, the tip, “Selection
Tool (V)” appears in a yellow box. The letter in parentheses is the keyboard shortcut
for selecting this tool. Tooltips are available for all the tools in the toolbox and for
all palette controls. 

If you find that the tooltips are getting in the way and you are expert enough that
you don’t need them popping up every time you pause for a second, you can disable
them with an option in the General screen of the Preferences dialog box. This dialog
box can be opened using the Illustrator [Edit] ➪ Preferences ➪ General menu option.

Palettes
Illustrator has more than two dozen palettes, all of which can remain open while
you work on your document (providing you can still see your document through all
those palettes!). Technically speaking, a palette is a window. Everything on the Mac
and in Windows is a window except the desktop. Movable modeless windows
(palettes) are variations on windows.

A modeless window is different than a dialog box in that it doesn’t require the
window to be closed before other operations can be performed. This lets you
work with the settings in the palette without having to close the palette.

Palettes are like regular windows in many ways. They have a title bar that can be
clicked and dragged to move the palette. Under the title bar is a tab that contains
the name of the palette. A close button usually appears in the upper corner of the
palette that you can use to hide the palette. The title bar also includes a button
that toggles between Minimize and Maximize for Windows or a Zoom button for the
Macintosh OS. This button will toggle between displaying only the palette title tab
or the entire palette. You can also toggle between these two states by double-
clicking the title tab. Figure 1-7 shows the Navigator palette.

Note
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15Chapter 1 ✦ Learning the Illustrator Interface

Figure 1-7: The Navigator palette 

Occasionally, a manual resize box (which looks like three diagonal lines) appears in
the lower-right corner for changing the palette’s size. Any palette that has this
resize box can be resized by dragging on the palette’s edges or corners. 

For some palettes, a double arrow icon appears to the left of the title name.
Clicking this icon toggles the palette size among several different sizes.

Unlike windows, palettes are never really active. Instead, the one you are working in
is in the front, and if it has editable text fields, one is highlighted, or a blinking text
cursor appears. To bring a palette to the forefront — that is, bring it into focus —
simply click it anywhere. Palettes seldom have scroll bars, although the Layers
palette is an exception.

Tabbing and docking palettes
Palettes can be linked together in different ways called tabbing and docking. Each
palette (except for the toolbox) has a tab on it. Clicking the tab of a palette brings
it to the front. Dragging a tab from one palette to another moves that palette into
another palette. Dragging a tab out of a palette makes the palette separate from
the previous palette. Figure 1-8 includes a “set” of palettes that have been tabbed
together.

The default installation of Illustrator includes many palettes that are tabbed
together, but you can change them to fit your needs. For example, the Appearance,
Navigator and Info palettes are tabbed together by default. 

You can dock palettes together by dragging the tab of one palette to the bottom of
another palette; when the bottom of the other palette darkens, releasing the mouse
button “docks” the moved palette to the bottom of the other one. Then, when the
other palette is moved, the docked palette moves with it. Figure 1-9 shows a “set”
of palettes that have been docked together. To undock a palette, simple click on its
tab and drag it away from the other palettes. 

Note

Tip

Palette tab Close

Minimize/maximize toggle
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16 Part I ✦ Illustrator Basics

Figure 1-8: Several palettes
have been tabbed together 

Figure 1-9: A set of palettes 
that have been docked 
together

Showing and hiding palettes
The palettes are only helpful if you can access them and the Windows menu can
be used to show or hide all the various palettes available in Illustrator. In addition
to the palettes, you can use the Windows menu to show or hide the Toolbox, the
library palettes, as well as any documents that are currently open. For all palette
commands, the command will read “Show x palette” if the palette is hidden, and
“Hide x palette” if the palette is visible. Many palettes have keyboard shortcuts
that can be used to show them. These shortcuts are listed to the right of the palette
option in the Windows menu. 
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17Chapter 1 ✦ Learning the Illustrator Interface

The Windows menu will place a checkmark to the left of all the palettes that are
currently open. 

The various palettes
The content of the various palettes will be covered throughout the remainder of
the chapters, but a summary of the available palettes is presented here and the
keyboard shortcut, if available, will be listed in parentheses. They are listed as
they appear in the Window menu alphabetically.

Several of these palettes are new to Illustrator 10 including: Document Info,
Flattening Preview, Magic Wand, Symbols, Type and Variables.

✦ Actions palette: The Actions palette can record a sequence of commands that
can be replayed at any time.

✦ Align palette (Shift + F7): The Align palette provides functions for aligning
objects in your document.

✦ Appearance palette (Shift + F6): The Appearance palette shows various
attributes of the current object such as stroke weight and fill color.

✦ Attributes palette (F11): The Attributes palette contains settings such as
Overprint options and a URL.

✦ Brushes palette (F5): The Brushes palette can be used to select a unique
brush to paint with.

✦ Color palette (F6): The Color palette is used to apply color to objects.

New
Feature

ASK TOULOUSE: Moving Palettes 

Kramer: When I start Illustrator, these tiny windows are everywhere.

Toulouse: Those are palettes.

Kramer: But I thought palettes are boards with daubs of paint of them.

Toulouse: Some Illustrator palettes hold colors, patterns and even styles. 

Kramer: Oh, I’ve got plenty of style.

Toulouse: I’m sure you do.

Kramer: But, these palettes get in the way of my drawing space.

Toulouse: If you click and drag on the palette you can place it anywhere you want.

Kramer: Great! Now stay palette. Stay!

Toulouse: The palettes are very well behaved. They will stay where you put them even after
you close and reopen Illustrator.

Kramer: Hey, that’s okay.
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18 Part I ✦ Illustrator Basics

✦ Document Info palette: The Document Info palette shows information about
the current document such as its name, Color Profile and dimensions. 

✦ Gradient palette (F9): The Gradient palette is used to modify gradient color
and spacing. The Gradient palette also appears automatically when the
Gradient tool is double-clicked.

✦ Info palette (F8): The Info palette shows information about the current selec-
tion. The Info palette appears automatically when the Measure tool is used.

✦ Layers palette (F7): The Layers palette can be used to organize artwork into
independent layers.

✦ Links palette: The Links palette shows the embedded images that are linked
to the current file.

✦ Magic Wand palette: The Magic Wand palette includes options for the Magic
Wand tool.

✦ Navigator palette: The Navigator palette assists you in moving around your
document.

✦ Pathfinder palette (Shift + F9): Pathfinder functions are used to control how
paths interact with each other.

✦ Stroke palette (F10): The Strokes palette is used to apply and change strokes
that are applied to paths.

✦ Styles palette (Shift + F5): The Styles palette organizes and applies styles to
objects.

✦ SVG Interactivity palette: The SVG Interactivity palette lets you define
interactive events that can be used with the Scalable Vector Graphics
(SVG) format.

✦ Swatches palette: The Swatches palette contains preformatted gradients,
colors, and patterns.

✦ Symbols palette (Shift + F11): The Symbols palette holds and organizes
symbols.

✦ Tools palette: This is the toolbox that holds all the tools.

✦ Transform palette (Shift + F8): The Transform palette is used to make
transformations (including move, scale, and rotate) to selected objects.

✦ Transparency palette (Shift + F10): The Transparency palette lets you set
the opacity of the current object.

✦ Type ➪ Character palette (Ctrl + T): The Type ➪ Character palette sets the
font and format for the selected characters.

✦ Type ➪ MM Design palette: The Type ➪ MM Design palette includes the
setting for any Multi Master fonts installed on your system. 

✦ Type ➪ Paragraph palette (Ctrl + M): The Type ➪ Paragraph palette sets the
format for the selected paragraph.
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✦ Type ➪ Tab Ruler palette (Ctrl + Shift + T): The Type ➪ Tab Ruler palette can
be used to set tab breaks.

✦ Variables palette: The Variable palette includes an interface for defining data
variables for data driven graphics.

Using Illustrator’s menus
Menus are one of the most common interface elements for all software packages.
Over time, Adobe has pushed a lot of their functionality to the palettes and other
interface elements rather than the menus, but menus are still important and offer
another way to work with the program. Some general rules apply to Illustrator
menus:

✦ To select a menu item, pull down the menu, highlight the menu item you
want, and release or click the mouse button (Macintosh) or click that item
(Windows). If the cursor is not on that item, but it is still highlighted, the
command will not take effect.

✦ Whenever an ellipsis appears (three little dots that look like this . . .), choosing
that menu item brings up a dialog box where you must verify the current
information by selecting an OK button, or enter more information and then
select OK. If the option has no ellipsis, the action you select takes place right
away.

✦ When you see a key command listed on the right side of the menu — usually
the Command (Ô) symbol and a character for Macintosh or Ctrl plus a char-
acter for Windows, but sometimes the Ô symbol [Ctrl] or another modifier
key plus a character — you can type that key command instead of using the
mouse to pull down this menu. Using key commands for menu items works
just like clicking the menu bar and pulling down to that item.

✦ If you see a little triangle next to a menu item, it means the menu has a submenu
associated with it. You can choose items in the submenu by pulling over to
the menu and then pulling up or down to select the menu item needed.
Submenus usually appear on the right side of the menu, but due to space limi-
tations on your monitor, they may appear on the left side for certain menus.

Palette menus
In addition to the main interface menus, many palettes have their own menus. In
the upper right corner of many palettes is a round button with an arrow on it. This
button will open a fly-away menu of palette options. Figure 1-10 shows the Color
palette with its palette menu visible. 
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Tips for Using Menus Effectively

If you can never remember what is on which menu and you are constantly holding down
the mouse button while slowly running along the menu bar, reading every menu item and
looking for a certain command, you have a disease. Every year millions of people become
afflicted with Menu Bar Scanning Syndrome (MBSS), defined as “the pathological need of
users to continually search and hunt for special menu items that they just can’t remember
the locations of.”

MBSS is a disease that can be treated fairly easily, but it wastes valuable production time,
costing companies billions of dollars a year. Don’t be surprised if the next time you flip to
60 Minutes, Steve Kroft is doing an inside investigation into the mysteries of MBSS.

MBSS is deadly not only because it wastes time, but because the user is forced to read
every single menu and pop-up menu. Sure, in the File menu you know that Document
Setup is where to go to change the size of the page, but as you work your way over, things
begin to get a little fuzzy. By the time you get to the Filter menu, your mind is mush. You see
the Distort category and figure that all the submenu items are legal functions. If you can
manage to get to the Windows menu, thewordswouldjustruntogether, making no sense
whatsoever.

You can help prevent MBSS by doing one of two things:

✦ Memorize what is in each menu. This is the hardest thing to do, but a few hours
spent memorizing each menu item and where it goes will eventually prevent count-
less MBSS-related searches. Make sentences out of the first letters of each menu
item, if it helps. The File menu is either, “New, Open, Open Recent Files, Revert,
Close, Save, Save As, Save a Copy, Save for Web, Place, Export, Preview AlterCast in
Browser, Manage Workgroup, Scripts, Document Setup, Document Color Mode, File
Info, Separation Setup, Print Setup, Print, Exit” or “Nine Old Odd Red Cats See Seven
Severely Silly People Eating Purple Mashed Sour Damp Danish Flowered Soggy
Pieces of Pruned Eggplant.” (Yeah, yeah — you’re not supposed to eat pruned egg-
plant when it’s damp. That’s why these seven people are silly.) Of course, having to
learn a new crazy sentence like this every time a new version is released becomes
more and more difficult as new commands are added. 

✦ Use the menus as little as possible. Instead, memorize key commands. Most of
the menu items have them, so you only need to go up to the menu bar when a
menu item doesn’t have a key command. If you set your own keyboard commands
using the Keyboard Shortcuts command (choose Edit ➪ Keyboard Shortcuts), you
can set a keyboard command for every menu item in Illustrator.

033658-3 ch01.F  1/24/02  12:59 PM  Page 20



21Chapter 1 ✦ Learning the Illustrator Interface

Figure 1-10: The palette menu offers 
additional options 

Context-sensitive menus
Illustrator provides context-sensitive menus that appear right under your cursor as
you’re working. Control+click [right-click] with a cursor anywhere in the document
window, and a context-sensitive menu appears. These menus contain commands
that relate to the type of work you’re doing and the specific tool you have. Figure 1-11
shows a context-sensitive menu that appears in a document when a rectangle shape
is created and selected. This menu would look different if some other object were
selected. 

Figure 1-11: A context-sensitive menu appears by right-clicking in the docu-
ment window. 
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Typing keyboard commands
Keyboard commands are shortcuts for common activities that you perform in
Illustrator. These shortcuts typically use the Ô [Ctrl] key in combination with
other keys.

Many of the Illustrator menu items have keyboard shortcuts listed next to their
names. Pressing the key combination does the same thing as choosing that menu
item from the menu. Some menu items do not have keyboard commands; usually,
you have to choose those items from the menu.

On a Macintosh, common keys that are used with the Ô key are the Option key
(located handily next to the Ô key) and the Shift key. The Control key is used only
to simulate the right mouse button that Windows users have (OS X also supports
a multi-button mouse). By default, no keyboard commands use the Control key,
although you can assign them if you wish. You hold down these keys while you
press another key or click the mouse to perform a specific function.

On a Windows system, the Ctrl key is used along with the Alt and Shift keys. If you
press certain combinations of these keys while pressing another key or clicking the
mouse, the related function activates.

In Appendix B, “Shortcuts in Illustrator 10,” you can find a complete listing of the
default key commands for Macintosh and Windows systems. You can learn how to
make your own custom keyboard shortcuts in Chapter 15, “Customizing and
Optimizing Illustrator.”

Keyboard commands are as important to an Illustrator artist as the mouse is; with
a little practice, you can learn them quickly. Besides, many of the default keyboard
commands are the same from program to program, which will make you an instant
expert in software that you haven’t used yet! Good examples of this are the Cut/
Copy/Paste set of commands (Ô+X, C, V [Ctrl+X, C, V]), Select All (Ô+A [Ctrl+A]),
and Save (Ô+S [Ctrl+S]).

Using the status bar
In the lower-left corner is the status bar, which includes a Zoom drop-down list and
a button that displays all sorts of neat information you just can’t get anywhere else.
The default is usually set to display the name of the current tool, but if you click on
the status bar, you can select from the following options:

✦ Current Tool: Displays the name of the selected tool.

✦ Date and Time: Displays the current date and time. 

✦ Free Memory: Displays a percentage and the amount of RAM that is free and
available.

✦ Number of Undos: Displays the number of undos and redos that are queued. 

✦ Document Color Profile: Displays the current Color Profile. 

Cross-
Reference

033658-3 ch01.F  1/24/02  12:59 PM  Page 22



23Chapter 1 ✦ Learning the Illustrator Interface

Navigating Around Your Document
Being able to move through a document easily is a key skill in Illustrator. Rarely can
you fit an entire illustration in the document window at a sufficient magnification to
see much of the image’s detail. Usually you are zooming in, zooming out, or moving
off to the side, above, or below to focus in on certain areas of the document.

Mousing Around in Illustrator

Illustrator requires the use of a mouse for selecting items, pulling down menus, moving
objects, and clicking buttons. Learning to use the mouse efficiently requires patience, prac-
tice, and persistence. In most programs, you can master using the mouse quickly, but using
the mouse with Illustrator’s Pen tool can be difficult at first. If you’re unfamiliar with using a
mouse, a fun way to get used to working with one is by playing a mouse-driven game. After
several hours of play (providing you don’t get fired by your employer or kicked out of the
house by your irritated spouse), you’ll become Master of Your Mousepad, King of Your
Klicker, and so on.

The mouse is used to perform five basic functions in Illustrator:

✦ Pointing, which is moving the cursor around the screen by moving the mouse
around your mousepad.

✦ Clicking, which is pressing and releasing the mouse button in one step. Clicking is
used to select points, paths, and objects, and to make windows active. (Windows
users: “Clicking” means clicking with the left mouse button, unless you’ve reconfig-
ured your mouse.)

✦ Dragging, which is pressing the mouse button and keeping it pressed while you
move the mouse. You drag the cursor to choose items from menus, select contigu-
ous characters of text, move objects, and create marquees.

✦ Double-clicking, which is quickly pressing and releasing the mouse button twice
in the same location. Double-clicking is used to select a word of text, select a text
field with a value in it, access a dialog box for a tool, and run Illustrator (by double-
clicking its icon).

✦ Control+clicking [right-clicking], which displays a context-sensitive menu when
you press Control and click on the Mac (Windows users only need to press the right
mouse button).

The cursor is the little icon (usually an arrow) that moves in the same direction as the
mouse. (If the cursor seems to be moving in the opposite direction from the mouse, check
that the mouse isn’t upside down, or, heaven forbid, that you aren’t upside down yourself.)
In Illustrator, the cursor often takes the form of a tool that you are using. When the
computer is busy doing whatever a computer does when it is busy, an ugly little watch or a
multicolored spinning circle (Macintosh) or hourglass (Windows) takes its place.
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Who’s zoomin’ who?
The most basic navigational concept in Illustrator is the ability to zoom to different
magnification levels. Illustrator’s magnification levels work like a magnifying glass.
In the real world, you use a magnifying glass to see details that aren’t readily visible
without it. In the Illustrator world, you use the different magnification levels to see
details that aren’t readily visible at the 100-percent view.

Changing the magnification levels of Illustrator does not affect the illustration itself.
If you zoom in to 200 percent and print, the illustration will still print at the same
size as it would if the view were 100 percent. It will not print twice as large. Figure 1-12
shows the same Illustrator document at 100 and 200 percent magnification.

Figure 1-12: An Illustrator document at 100 percent (left) and 200 percent (right)
magnifications

In Illustrator, 100 percent magnification means that the artwork you see on the
screen has the same physical dimensions it will have when it prints. If you were
to put a printout next to the onscreen image at 100 percent magnification, it
would appear to be exactly the same size, depending on your monitor resolution
(the higher the resolution, the smaller the document will look onscreen). If you’re
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designing for the Web, 100 percent works correctly (the result will be at 100 percent
as well), because the Save for Web feature automatically converts images to 72 ppi
(the “standard” screen resolution for cross-platform viewing).

In Photoshop, 100-percent view is different from Illustrator. In Photoshop, each
pixel onscreen is equal to one pixel in the image. Unless the pixels per inch (ppi)
of the image match those of the screen (and they would if Web graphics were being
designed), the 100-percent view tends to be larger than the printed dimensions of
the image.

Using the Zoom tool
Perhaps the easiest way to control the magnification of your artwork is with the
Zoom tool. This tool (which looks like a magnifying glass and is located in the right
column of the Toolbox) can magnify a certain area of artwork and then return to the
standard view.

To use the Zoom tool to magnify an area, select it in the toolbox by clicking it once.
The Zoom cursor takes the place of the Arrow cursor (or whatever tool was previ-
ously selected). It looks like a magnifying glass with a plus sign in it. Clicking any
spot in the illustration enlarges the illustration to the next magnification level, with
the place you clicked centered on your screen. The highest magnification level is
6,400 percent — which, as all you math aficionados know, is 64 times (not 6,400
times!) bigger than the original.

Where you click with the Zoom tool is very important. Clicking the center of the
window enlarges the illustration to the next magnification level, but the edges (top,
bottom, left, and right) of the document (and possibly some or all of your artwork)
will disappear as the magnification increases. Clicking the upper-right corner hides
mostly the lower-left edges, and so forth. If you are interested in seeing a particular
part of the document close up, click that part at each magnification level to ensure
that it remains in the window.

If you zoom in too far, you can use the Zoom tool to zoom out again. To zoom out,
press the Option [Alt] key when you have the Zoom tool active (releasing the Option
[Alt] key restores the Zoom In tool). Clicking with the Zoom Out tool reduces the
magnification level to the next lowest level. You can zoom out to 3.13 percent (1/32
actual size). When you hold down the Option [Alt] key the Zoom cursor displays a
minus sign within the magnifying glass.

When you use the Zoom tool, you magnify everything in the document, not just
the illustration. You magnify all paths, objects, the artboard, and the Page Setup
boundaries equally. However, the way certain objects appear (the thickness of
path selections, points, handles, gridlines, guides, and Illustrator user interface (UI)
components such as palettes and windows) does not change when you zoom in.
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If you need to zoom in to see a specific area in the document window, use the Zoom
tool to draw a marquee (by clicking and dragging diagonally) around the objects
that you want to magnify. The area thus will magnify as much as possible so that
everything inside the box just fits in the window that you have open, as shown in
Figure 1-13. Dragging a box while holding down the Option [Alt] key to zoom out
does nothing special; it works the same as if you had just clicked to zoom out.

Figure 1-13: Zooming in to a certain area in the original image (left) results in the
magnification and placement of the image as shown on the right.

To move a zoom marquee around while you’re drawing it, press and hold the space-
bar after you’ve begun drawing the marquee but before you release the mouse
button. When you release the spacebar, you can continue to change the size of the
marquee by dragging.

Other zooming techniques
You also can zoom in and out by using commands in the View menu. Choose View ➪
Zoom In ( ➪ cmd[Ctrl]++) to zoom in one level at a time until the magnification level
is 6,400 percent. The Zoom In menu item zooms from the center out. Choose View ➪
Zoom Out ( ➪ cmd[Ctrl]+-) to zoom out one level at a time until the magnification
level is 3.13 percent.

Tip
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Even though Illustrator can zoom to any level, 17 default zoom levels are used when
the Zoom tool is clicked, or when the Zoom In and Zoom Out menu items (or their
respective keyboard commands) are accessed. Table 1-1 lists each of the default
Zoom In and Zoom Out default levels.

Table 1-1
Zoom In and Zoom Out Default Levels

Zoom Out Ratio Zoom In Ratio

100% 1:1 100% 1:1

66.67% 2:3 150% 3:2

50% 1:2 200% 2:1

33.33% 1:3 300% 3:1

25% 1:4 400% 4:1

16.67% 1:6 600% 6:1

12.5% 1:8 800% 8:1

8.33% 1:12 1,200% 12:1

6.25% 1:16 1,600% 16:1

4.17% 1:24 2,400% 24:1

3.13% 1:32 3,200% 32:1

4,800% 48:1

6,400% 64:1

Zooming to Actual Size
You can use several different methods to automatically zoom to 100-percent view.
The first method is to double-click the Zoom tool slot in the toolbox. This action
changes the view to 100 percent instantly. Selecting 100% from the Zoom drop-
down list in the lower left corner of the interface will also size the document to
100 percent. But perhaps the best way to zoom to 100-percent magnification is to
choose View ➪ Actual Size (Ô[Ctrl]+1), which not only changes the image size
to 100 percent but also centers the page in the document window. 

Zooming to Fit in Window size
You can choose from two different methods to change the document view to the Fit
in Window size. Fit in Window instantly changes the magnification level of the docu-
ment so that the entire artboard (not necessarily the artwork, if it isn’t located on
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the page) fits in the window and is centered in it. One way to automatically change
to the Fit in Window view is to choose View ➪ Fit in Window ( ➪ cmd[Ctrl]+0).
Another way is to double-click the Hand tool slot.

You can quickly go to 3.13 percent by Command [Ctrl]+double-clicking the Zoom
tool slot in the toolbox.

Zooming to a specific magnification
If you’d like to view a document at a specific zoom level, double-click the view area
at the bottom-left corner of Illustrator’s window (shown in Figure 1-14), type the
magnification you wish to zoom to and press Enter or Return.

Figure 1-14: Enter the exact zoom level you wish to zoom to in the field at the 
lower-left corner of the document window.

You can never undo any type of magnification level change because zooming only
changes the view of the document, it doesn’t change the actual document in any
way. Choosing Edit ➪ Undo after zooming undoes the last change you made to the
document before you changed the magnification level, not the magnification level
change.

Tip
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Zooming with the Navigator palette
Of course, being able to zoom in very closely to your artwork does have a pitfall:
The more you zoom in on an illustration, the less of that illustration you see at one
time. The Navigator palette (shown in Figure 1-15) helps you out by letting you see
the entire illustration as well as the portion you’re zoomed into (indicated by a red
viewing rectangle). You can stay zoomed in and move easily to another section by
dragging the red rectangle within the Navigator palette to another area. Access the
Navigator palette by choosing Window ➪ Show Navigator.

Figure 1-15: The 
Navigator palette

You can zoom in and out a preset amount (using the same amounts used by the
Zoom In and Zoom Out tools and menu items) by pressing the Zoom In or Zoom
Out button. Another way to zoom in and out is to drag the slider to the left or right.
You can also type in an exact magnification level in the box in the lower-left corner
of the Navigator palette.

The Navigator palette’s fly-away menu includes a View Artboard Only option. This
option sets the thumbnail in the Navigator palette to show only the extent of the
artboard. If this option isn’t set, then the thumbnail shows all objects included in
the document.

The Navigator palette can slow down Illustrator if your artwork contains many pat-
terns, gradients, and gradient mesh objects. To avoid this slowdown, you can close
the Navigator palette using the Window ➪ Hide Navigator option.

Using the scroll bars to view your document
Sometimes, after you zoom in to a high magnification, part of the drawing that you
want to see is outside the window area. Instead of zooming in and out repeatedly,

Caution

Enter zoom amount

Zoom in Zoom out

Zoom slider

Rectangle
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you can use one of two different scrolling techniques to move around inside the
document.

The scroll bar on the right side of the document window controls where you are
vertically in the document. Clicking the up arrow displays what is above the window’s
boundaries by pushing everything in the window down in little increments. Clicking
the down arrow displays what is below the window’s boundaries by pushing the
document up in little increments.

Dragging the thumb (sometimes called an elevator box) up displays what is above
the window’s boundaries proportionately by whatever distance you drag it. (Be
careful not to drag too far or you will be previewing beyond the top of the artboard.)
Dragging the thumb down displays what is below the window’s boundaries propor-
tionately by whatever distance you drag it. Clicking the gray bar above the thumb
and between the arrows displays what is above the window’s boundaries in big
chunks. Clicking the gray bar below thumb, between the arrows, displays what is
below the window’s boundaries in big chunks.

For Mac OS X systems, you can set in the System Preferences, the amount of
scrolling that happens when you click within the scrollbar. 

The gray area of the right scroll bar is proportionate to the vertical size of the paste-
board (the space around the artboard). If the little elevator box is at the top of the
scroll bar, then you are viewing the top edge of the pasteboard. If it is centered, you
are viewing the vertical center of the pasteboard.

The scroll bar on the bottom of the document window controls where you are hori-
zontally in the document. Clicking the left arrow displays what is to the left of the
window’s boundaries by pushing everything in the window to the right in little
increments. Clicking the right arrow displays what is to the right of the window’s
boundaries by pushing the document to the left in little increments. Dragging the
thumb to the left displays what is to the left of the window’s boundaries proportion-
ately by whatever distance you drag it. Dragging the thumb to the right displays
what is to the right of the window boundaries proportionally by whatever distance
you drag it. Clicking the gray bar, between the arrows, that is to the left of the thumb
displays what is to the left of the window’s boundaries in big chunks. Clicking the
gray bar, between the arrows, that is to the right of the thumb displays what is to
the right of the window’s boundaries in big chunks.

Scrolling with the Hand tool
The Hand tool, which looks like a hand (surprise, surprise), improves on the scroll
bars. Instead of being limited to horizontal and vertical movement only, you can use
the Hand tool to scroll in any direction, including diagonally. It is especially useful
for finding your way around a document when you’re viewing it at a high magnifica-
tion level. The higher the magnification level, the more you’re likely to use the Hand
tool.

Note
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To use the Hand tool, select it from the Hand tool slot in the toolbox.

To quickly access the Hand tool, press H, or press and hold the spacebar. Clicking
and dragging the page moves the document around inside the document window
while the spacebar is held down. If you release the spacebar, then you return to
the previous tool. This works for all tools, but the Type tool works a little differently.
If you’re currently using the Type tool in a text area, press Ô+spacebar [Ctrl+space-
bar] to access the Zoom tool, and release Ô [Ctrl] while keeping the spacebar
pressed to gain access to the Hand tool.

When you click in the document, be sure to click the side that you want to see.
Clicking at the top of the document and dragging down enables you to scroll down
through almost an entire document at a height of one window. Clicking in the center
and dragging enables you to scroll through only half a window’s size at a time. If the
window of the document does not take up the entire screen space, you can continue
to drag right off the window into the empty screen space. Just be sure to click first
within the document that you want to scroll.

Be warned that Illustrator doesn’t include support for a scrolling mouse except in
Mac OS X. A scrolling mouse includes a wheel button in between the two buttons
(if it’s a two-button mouse typical with Windows) that you can use to quickly scroll
around a page. The scrolling wheel has no effect on an Illustrator document. We
can hope that Adobe will support this type of mouse in the future. Mac OS X
includes support for the scrolling mouse as part of the operating system. 

The best thing about the Hand tool is that it works live. As you drag, the document
moves under “your Hand.” If you don’t like where it is going you can drag it back,
still live. The second best thing is that accessing it requires only one keystroke, a
press of the spacebar.

You cannot use Undo to reverse scrolling that you have done with the scroll bars
and the Hand tool.

Scrolling with the Navigator palette
Use the red viewing rectangle in the Navigator palette to scroll quickly to another
location within a document. Clicking and dragging within the red rectangle moves
the viewing area around “live,” whereas clicking outside the rectangle “snaps” the
view to a new location.

The red rectangle can be changed to another color by choosing the Palette
Options in the Navigator palette pop-up menu.

Tip

Note

Note

Tip
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Opening a new window
So now you’ve learned how to zoom and pan around the document window, so you
probably have many different sections of your artwork that you want to focus on.
Illustrator will let you create a number of windows for the current artwork using the
Window ➪ New Window option. 

This option will create a new window that is the same size as the current window.
You can then zoom and pan within this new window while maintaining the previous
window. These windows can then be placed side by side to see the artwork from
two unique perspectives. Each new window will be given a different reference num-
ber that appears in the title bar. 

Working in Outline mode 
versus Preview mode

In the old days, everyone worked in Outline mode (previously called Artwork
mode). In Outline mode you see only the “guts” of the artwork — the paths without
the fills and strokes applied. To see what the illustration looked like with the fills
and strokes applied, you had to switch to Preview mode. Usually the preview was
not quite what you had in mind, but to make changes, you had to switch back to
Outline, and then to Preview again to check, and so forth. Many users of Illustrator
from that time refer to it as the golden age, with not a little trace of sarcasm.

Today, Illustrator 10 enables you to edit your work in both Outline and Preview
modes, each shown in Figure 1-16. You can print a document from either mode.
Saving the document while you are in Outline mode does not affect anything in the
document, but the next time you open it, it will display in Outline mode. The same
thing applies to Preview mode: Whatever mode you are in is saved with the artwork.

You cannot undo a Preview or Outline mode change (going from Preview to Outline,
for example). If you make a Preview or Outline mode change and then close your
document, Illustrator asks you if you want to save changes, which in this case
would refer only to the view change.

The current view mode is always displayed in the title bar next to the document
name.
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Figure 1-16: Artwork shown in both Outline mode (left) and Preview mode (right)

Outline mode
To change the current document to Outline mode, choose View ➪ Outline. If you
are already in Outline mode, the view menu contains only an option to change
to Preview mode. In Outline mode, the illustration disappears and is replaced
onscreen by outlines of all the filled and stroked paths. Text that has yet to be
converted into outlines looks fine, although it is always black. Depending on your
choice in the Document Setup dialog box (choose File ➪ Document Setup), a placed
image is displayed as a box (if Show Placed Images option is not checked) or as a
black-and-white-only image surrounded by a box (if Show Placed Images option is
checked).
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Working with a drawing in Outline mode can be significantly faster than working
with it in Preview mode. In more complex drawings, the difference between Outline
mode and Preview mode is significant; on very slow computers, working in Preview
mode is next to impossible.

Outline mode enables you to see every path that isn’t directly overlapping another
path; in Preview mode, many paths can be hidden. In addition, invisible masks are
normally visible as paths in Outline mode. Outline mode is much closer to what the
printer sees — paths that define the edges of the objects you are working with.

Placed artwork is displayed in black and white only, and templates are grayer than
before. The main advantage to working in Outline mode is the speed increase over
Preview mode when you’re working with a complex image. The speed that you gain
is even greater when the artwork contains gradients, patterns, placed artwork, and
blends. In addition, you can select paths that were hidden by the fills of other
objects.

Outline mode can take some getting used to. To select paths in Outline mode, you
must click the paths directly or draw a marquee across them.

Outline mode can be better than Preview because it’s faster, and also because your
brain can learn to know what the drawing looks like from seeing just the outlines,
which show all of the paths.

Preview mode
Choosing View ➪ Preview changes the view to Preview mode. If you are already
in Preview mode, then the View menu contains only a menu option to change to
Outline mode. In Preview mode, the document looks just the way it will look when
you print it.

In Preview mode, the color you see on the screen only marginally represents what
the actual output will be because of the differences between the way computer
monitors work (red, green, and blue colors — the more of each color, the brighter
each pixel appears) and the way printing works (cyan, magenta, yellow, and black
colors — the more of each color, the darker each area appears). Monitor manufac-
turers make a number of calibration tools that decrease the difference between
what you see on the monitor and the actual output. You can also use software
solutions. One solution, CIE calibration, is built into Adobe Illustrator (choose
Edit ➪ Color Settings). Mac users can use ColorSync, which is part of the OS. 

In Preview mode, you can see which objects overlap, which objects are in front and
in back, where gradations begin and end, and how patterns are set up.

Note
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Instead of selecting a path by clicking it, you can select entire paths by clicking
the insides of those paths in a filled area. It becomes a little more difficult to 
select certain points on paths, because the strokes on those paths are also visible.
Sometimes so much stuff appears on your screen in Preview mode that you don’t
know what to click. The option that enables you to select an entire path by clicking
in a filled area is called Area Select, which is activated by a checkbox (turned on by
default) in the General Preferences dialog box, which you can access by choosing
Edit ➪ Preferences ➪ General.

You can stop screen redraw by pressing Ô+Y [Ctrl+Y] at any time. This is useful
if you would like to make a small change and would have to wait too long for the
redraw. Of course, pressing Ô+Y [Ctrl+Y] dumps you into Outline mode, but the
redraw happens pretty much instantaneously.

Overprint Preview mode
When producing color separations, you can specify overprinting features using the
Attributes palette. When colors are overlapped, the top color typically covers or
knocks out the colors underneath. However, when you use the Overprint feature,
the ink for the top color is printed on top of the lower colors. This process is easier
and mostly cheaper for printers to produce, but it can affect the overall color of the
objects. To view the results of specifying an overprint, you can use the Overprint
Preview option by selecting the View ➪ Overprint Preview option.

You can learn more about overprinting in Chapter 6, “Working with Color,” and in
Chapter 16, “Understanding Printing, Separations, and Trapping.”

Pixel Preview mode
Illustrator 10 includes many features to help designers create graphics for Web
pages. Web page graphics are typically pixel-based images. To help designers view
their pixel-based images before saving them to a Web graphics format, Illustrator 10
includes a Pixel Preview mode.

You can find more information about creating Web graphics in Chapter 17, “Using
Illustrator to Generate Web Graphics.”

You can enable the Pixel Preview option using the View menu. This option is tog-
gled on or off every time it is selected. If it is enabled, a checkmark appears next to
the menu option. When the Pixel Preview option is enabled, the current document
is displayed as a raster image (see Figure 1-17).

Cross-
Reference

Cross-
Reference

033658-3 ch01.F  1/24/02  12:59 PM  Page 35



36 Part I ✦ Illustrator Basics

Figure 1-17: This document is displayed in normal Preview mode (left) and using 
Pixel Preview mode (right).

Combining Outline and Preview modes
Using the Layers palette, you can easily combine Outline mode with either Preview
or Preview Selection mode. You can force individual layers to display in Preview
mode while other layers remain in Outline mode. This feature can be useful when
you have a layer with a placed image, gradients, or patterns (or all three) that
would normally slow down screen redraw, and your workflow. You can place
those images on their own layer and set that layer to Outline mode.

To learn more about using layers, check out Chapter 7, “Organizing Artwork.”

Using custom views
Illustrator has a special feature called custom views that enables you to save special
views of an illustration. Custom views contain view information, including magnifi-
cation, location, and whether the illustration is in Outline or Preview mode. If you
have various layers or layer sets in Preview mode and others in Outline mode,

Cross-
Reference
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custom views can also save that information. Custom views, however, do not record
whether templates, rulers, page tiling, edges, or guides are shown or hidden.

To create a new view, set up the document in the way that you would like to save
the view. Then choose View ➪ New View and name the view in the New View dialog
box, shown in Figure 1-18. Each new view name appears at the bottom of the View
menu. No default keyboard shortcuts exist for these views, but you can create your
own shortcuts using the Keyboard Shortcuts dialog box, available under the Edit
menu. You can create up to 25 custom views. Custom views are saved with a docu-
ment as long as you save it using the Illustrator format.

Figure 1-18: This simple dialog box lets 
you name the new view.

If you find yourself continually going to a certain part of a document, zooming in
or out, and changing back and forth between Preview and Outline mode, that docu-
ment is a prime candidate for creating custom views. Custom views are helpful for
showing clients artwork that you created in Illustrator. Instead of fumbling around
in the client’s presence, you can, for example, show the detail in a logo instantly if
you have preset the zoom factor and position, and have saved the image in a custom
view.

Once views are created, you can edit the view name or delete them using the View ➪
Edit Views option. This will open the Edit Views dialog box, shown in Figure 1-19. To
rename the view, select it and type the new name in the Name field. To delete a
view, select it and press the Delete button. 

Figure 1-19: The Edit Views dialog box 
can be used to rename or delete 
custom views.
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Using screen modes
So you’ve been working on an illustration for an important client (actually they all
are important) and they scheduled an appointment to see your progress, but the
best part of the work is hidden behind the palettes and the Toolbox. These can be
easily turned off using the Window menu or you could use the F keyboard
shortcut to switch between the different screen modes. 

Illustrator uses three different screen modes represented by the three icon buttons
at the bottom of the Toolbox. They are Standard Screen Mode, Full Screen Mode
with Menu Bar and Full Screen Mode. You can toggle between these modes using
the F keyboard shortcut. Figure 1-20 shows Nichiro Newt in Full Screen Mode with
Menu Bar. 

Figure 1-20: Full Screen Mode with Menu Bar maximizes the document window 
to fill the entire screen eliminating all interface elements except for the menu bar.

Using the Edit Commands
In most software, including Illustrator, many of the most basic functions of the Edit
menu work the same way. If you’ve used the Edit menu in Photoshop or Microsoft
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Word, for example, you should have no trouble using the same functions in
Illustrator, because the menu options are located in the same place in each
program.

Using the Clear command
The most simplistic Edit command is Clear, which in Illustrator works almost
exactly like the Delete [Backspace] key on the keyboard. When something is
selected, choosing Clear deletes, or gets rid of, what is selected.

You’re probably asking yourself, “If the Delete [Backspace] key does the same thing,
why do we need Clear?” or “Why didn’t they just call the Clear command Delete
[Backspace]?” Ah, the makers of Illustrator are a step ahead of you in this respect.
Note that we said “almost” the same way; there actually is a subtle yet important
difference in what the Clear command does and what the Delete [Backspace] key
does, due to Illustrator’s abundant use of palettes.

If you are working on a palette and have just typed a value in an editable text field,
the Delete [Backspace] key deletes the last character typed. If you tabbed down or
up to an editable text field, highlighting text, or dragged across text in an editable
text field, highlighting text, then the Delete [Backspace] key deletes the highlighted
characters. In all three situations, the Clear command deletes anything that is
selected in the document.

Cutting, copying, and pasting
The Cut, Copy, and Paste commands in Illustrator are very handy. Copying and cut-
ting selected objects places them on the clipboard, which is a temporary holding
place for objects that have been cut or copied. After an object is on the clipboard,
it may be pasted into the center of the same document, the same location as the
cut or copied object, or another document in Illustrator, InDesign, Photoshop,
Dimensions, or Streamline.

Choosing Cut from the Edit menu deletes the selected objects and copies them to
the clipboard, where they are stored until another object is cut or copied or the
computer is shut down or restarted. Quitting Illustrator does not remove objects
from the clipboard. Cut is not available when no object is selected.

Choosing Copy from the Edit menu works like Cut, but it doesn’t delete the selected
objects. Instead, it just copies them to the clipboard, at which time you can choose
Paste and slap another copy onto your document.

Choosing Paste from the Edit menu places any objects on the clipboard into the
center of the document window. If type is selected with the Type tool, or copied
from another application to the pasteboard, either a Rectangle type, Area type, Path
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type, or point type area must be selected with the Type tool. Paste is not available if
nothing is in the clipboard.

Illustrator also includes Paste in Front (Ô/Ctrl+F) and Paste in Back (Ô/Ctrl+B)
options that can be used to control the position of the object being pasted relative
to the other objects. 

Now, the really cool part: Just because you’ve pasted the object somewhere doesn’t
mean it isn’t in the clipboard anymore. It is! You can paste again and again, and
keep on pasting until you get bored, or until your page is an indecipherable mess,
whichever comes first. The most important rule to remember about Cut, Copy, and
Paste is that whatever is currently in the clipboard will be replaced by anything
that subsequently gets cut or copied to the clipboard.

Cut, Copy, and Paste also work with text that you type in a document. Using the Type
tools, you can select type, cut or copy it, and then paste it. When you’re pasting type,
it will go wherever your blinking text cursor is located. If you have type selected
(highlighted) and you choose Paste, the type that was selected is replaced by what-
ever you had on the clipboard.

You can cut or copy as much or as little of an illustration as you choose; you are
only limited by your hard disk space (which is only used if you run out of RAM). A
good rule of thumb is that, if you ever get a message saying you can’t cut or copy
because you are out of hard disk space, it’s time to start throwing out stuff on your
hard drive that you don’t need. Or, simply get a bigger hard drive.

Thanks to the Adobe PostScript capability on the clipboard, Illustrator can copy
paths to other Adobe software, including InDesign, Dimensions, Streamline, and
Photoshop. Paths created in those packages (with the exception of InDesign) can
be pasted into Illustrator. With Photoshop, you have the option of pasting your
clipboard contents as rasterized pixels instead of as paths.

You have the ability to drag Illustrator artwork from an Illustrator document right
into a Photoshop document. In addition, because Adobe lets you move things in
both directions, you can drag a Photoshop selection from any Photoshop document
right into an Illustrator document.

Undoing and redoing
You can keep undoing in Illustrator until you run out of either computer memory
or patience. After you undo, you can redo by choosing Redo, which is found right
below Undo in the Edit menu. And, guess what — you can redo everything you’ve
undone.

Note
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Choosing Undo from the Edit menu undoes the last activity that was performed on
the document. Successive undos undo more and more activities, until the document
is at the point where it was opened or created or you have run out of memory.

The default minimum number of remembered undos is five. To change the mini-
mum number of undos, go to the Units and Undo Preferences dialog box (Illustrator
[Edit] ➪ Preferences ➪ Units and Undo) and type in the minimum number of undos
that you want. You can set the minimum undo levels to zero, but we wouldn’t rec-
ommend it; this might disallow any undo or redo operations in certain situations
and is like tightrope walking without a safety net.

Choosing Redo from the Edit menu redoes the last undo. You can continue to redo
undos until you are back to the point where you started undoing or you perform
another activity, at which time you can no longer redo any previous undos.

If you undo a couple of times and then do something, you won’t be able to redo. You
have to undo the last thing you did and then actually do everything again. In other
words, all the steps that you undid are gone. It’s fine to use the Undo feature to go
back and check out what you did, but after you have used multiple undos, don’t do
anything if you want to redo back to where you started undoing from. Got that?

Summary
In this chapter, you learned

✦ Illustrator may seem difficult to learn at first, but with this book and a bit of
dedication, you can master it.

✦ Many of the user interface elements that are found in Illustrator are common
among Adobe products. 

✦ Common user interface elements include the document window, the toolbox,
palettes, menus, and the status bar. 

✦ You can view Illustrator documents at virtually any magnification level with-
out actually changing them.

✦ The Hand tool is used to pan the document window. 

✦ Illustrator’s Outline mode lets you see paths without their strokes and fills.

✦ The Edit menu commands can be used to undo and redo commands, as well
as cutting, copying, and pasting objects. 

✦ Illustrator provides virtually unlimited undos and redos.

✦ ✦ ✦
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